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REMOTE SNAP INTRODUCTION

— HP’s first entry-level controller based replication software

— Remote Snap is an asynchronous, controller-based replication process
based on Snapshot. Deployments include:

« Across geographic distance over Ethernet

« Across “campuses” over FC
— Builds on existing Volume Copy and Snapshot features
— Copies only changed blocks, extremely efficient operation

— Remote Snap is a pull operation so the remote site will be pulling the
information from the local site

— Requires a network connection between two P2000 G3 Arrays

— HP exclusive ease-of-use content with replication setup wizard




CUSTOMER NEEDS ADDRESSED BY REMOTE
SNAP AND COMBO CONTROLLER

Need

P2000 G3 Remote Snap solution

Need: Protect data in
case of incidents leading
to loss of data on local

SAN

Software solution enabling snapshots of data
to reside on another array at a location
distant to primary SAN

Need: Share larger
departments’ storage
resources with smaller
groups at low cost

The P2000 Combo controller gives 8Gb FC
ports for departments needing high speed
access to data. It also provides TGbE ports to
allow smaller departments with tight
budgetary restrictions to enjoy shared storage
benetits without purchasing their own array —
and without the cost of implementing a FC
infrastructure.




REPLICATION BENEFITS

— Business Continuity / Disaster Recovery
«Improve Data Recoverability
— Instant restore to any point-intime snapshot

« Improve Business Continuity
— Reduced downtime and data unavailability due to system or human errors

- Rapid Application Development

— Use production data without effecting production data or impacting the production
application

— Regulatory Compliance
- Satisty Regulatory Compliance
— Data protection is mandatory
— Centralized Backup
«Reduce Backup Windows

— From hours to minutes
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REPLICATION PROCESS

How does the secondary volume determine what to transfer?

« Snapshot taken on primary volume - seen/referred to as a replication snapshot

« The primary volume sends notification that an replication operation has been
started
« The secondary volume requests a “difference list”

» The secondary volume replicates the changed blocks, based on the information
retrieved in the difference list

System 1

System 2

Read Request




P2000 SOFTWARE PRODUCT SKUS

SKUs Being Introduced:

512 - Snapshot LTU
HP P2000 Snapshot 512 Software LTU TABO06A

HP P2000 Snapshot 512 Software E-LTU TAB06AAE

Remote Snap LTU

HP P2000 Remote Snap Software LTU TABO08A

HP P2000 Remote Snap Software E-LTU TASO0SAAE
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P2000 G3 COMBO CONTROLLER
TWO 8GB FC PORTS / TWO 1G ISCSI PORTS

» Extend reach of SAN to servers that don’t have FC HBA's or FC SAN access
Provide IP-based centralized backup of FC SAN
 Snap Replication over IP or FC




P2000 G3 REMOTE SNAP
DISASTER RECOVERY FOR REMOTE SITES OVER IP (WAN)

Snapshot-based replication over Ethernet to enable Disaster Recovery.
« Snapshots replicated from Site “A” to Site “B”.
Initial replication can be done with a physical disk move.

Replication moves only new data across the wire.
Can be replicated over LAN/WAN using iSCSI ports, or over FC using FC ports.
Can hold 512 Snaps per array

Site “B” can mount the latest Snapshots to begin running as the primary online source.

Local Site “A” Remote Site B"

Dy

End-Users

LAN




P2000 G3 REMOTE SNAP
DISASTER RECOVERY FOR LOCAL CAMPUS OVER FC

Snapshot-based replication over FC to enable Disaster Recovery.
 Snapshots can be replicated between arrays w/out servers in the replication path
Initial replication can be done with a physical disk move.
* Replication moves only new data across the FC link.
« Upto 512 Snaps per array

Local Campus

Bldg A"

Corporate
LAN End-Users




P2000 G3 REMOTE SNAP
CENTRALIZED BACK UP OVER WAN

Remote Office #1
@ Application

Server #1
FC

Remote Snap Many-to-1 Replication (Centralization)

QAIl backup operations, equipment, and expenses eliminated from remote offices

OBackup operations consolidated and managed from a centralized location
QEnables geographic disaster recovery

—

Primary Primary
Volume #1 Snapshot #1

Remote Office #2

g Application

Server #2
FC

r'd
g—e

Primary Primary
Volume #2 Snapshot #2

Remote Office #3

g Application

Server #3
FC

'
ShadS

Primary Primary
Volume #3 Snapshot #3

Central Office
i Tape Library
Server =

©

~ Secondary Volume #1 Secondary Snapshot# 1
-
- ./

Secondary Volume Secondary Snapshot #2

00

Secondary Volume #3 Secondary Snapshot #3







PREREQUISITES

— Both Systems (local and remote) must have Remote Snap license installed

« A permanent license can be obtained by accessing the HP licensing server at
http://www.webware.hp.com

« It you do not have a permanent license you can use the built in 60-day trial license

— This cookbook is for HP P2000 G3 Arrays

« It desired you can upgrade the controllers in a MSA2000G 1 or G2 array to a G3 array
to get this functionality without having to migrate any data



http://www.webware.hp.com/

ENABLING A TRY-N-BUY LICENSE

%) Storage Management Utility

System Status
System Time  2090-03-10 14:21:53

Shaggy (P2000G3 FC/iSCSI)

View »  Provisioning  Configuration + Tools ~ \lizards ~ Help

SystemEvents €3 0 W 0 /. 0 (@ 100

Configuration View

Update Firmware
Install License

Shaggy (P2000G3 FCiiSCSI) > View > Overview

= System Overview save Logs
B [E Shagoy (P2000G3 FCASCSI) Select an entry from the table to see the detsils Reset Host Port
a Bl Logical Rescan Disk Channels
B vdisks System Overview Clear Digk Metadata
= va01 (RAIDS) O ok = Send Test Notification
&3 vd02 (RAIDS)
Hosts o @ ok Endlosures 1 26TE
B Physical @ @ox Disks 12 2.6TB
[H Enclosure 1 &) O oK Vdisks z 1.2TB
[E5 Fred (P2000G3 Feascsh .
® Volumes 2 40.0GE | I— et )
[Es smks (P2000G3 FCasCS))
@) Snap Pools 2 10768 . . .
(5] Snapshots 204
@ Schedules 0
@ Cenfiguration Limits
(@] Licensed Features
':::' Versions

1. Select the Storage Array in the left panel

2. Select “Tools”

3. Select “Install License”




INSTALLING THE 60-DAY TRIAL LICENSE

Install License

Install & temporary or permanent license

System Licenses

Licensed Snapshots 84 255 0 512 59 days
Volume Copy A Enabled A WA Mever
Replication M Enabled i WA 59 days
VDS A Enabled WA WA Mever
V55 hA Enabled WiA WA hever

“fou currently have a temporary license. You may install a permanent license.
Licensing Serial Number: D51343
Licensing Version Number: T201R08

Select a license file for upload:

| | Bronee...|

Temporary License Notice

D

Your temporary license will expire in 8 days. When you decide to license the product, contact your HP
partner for the appropriate software license.

— On the Install License screen

« First scroll down and accept the End
User License Agreement

+ Second confirm operation by clicking the
Yes button

= Your 60 frial period has now started

| Confirm Operation

Thank you for choosing to evaluate the advanced features ofthe storage system. The trial period is 60

days. The trial software was designed so that you can experience the functionality of this product prior to

purchase. Contact your HP partner for details on how to protect your data and to purchase a permanent
license.

When the trial license is close to
expiration, each login to the Storage

Array will display a pop-up message
with the number of days left in the trial
period.




FIRST REPLICATION CHECK LIST

— Prerequisites
- License
« Network configuration

« Create vdisks on both systems

« iSCSI addresses

— Create first replication

« Follow wizard steps

— Case Scenarios
» Local replication

« Backup
- DR




PRE-REPLICATION CHECK LIST

— Network Configuration

» Though not required the best practice is to replicate between two sites which have a
VPN connection

- Use network gear that can manage the network bandwidth

— Local System Configuration

» Add Remote System
» Configure iSCSI addresses (only required if iSCSI ports are used for replication)

— Remote Site Contiguration
» Configure iSCSI addresses

- Create a vdisk to replicate to




REMOTE SNAP SET UP REQUIREMENTS:
CONNECTING 2 SYSTEMS FOR REPLICATION

— Replication requires that the local and remote systems be able to communicate over the Ethernet
network

— Al iSCSI ports must be configured with IP address

— Both systems must be connected to Network via Ethernet switch Or via FC switch, if using FC to
replicate.

— The server accessing the replication set needs only be connected to the storage system host containing

the primary volume
Remote system
[Server 1] =ar

Local system

v Vv
Ethernet Switch

v WV
Ethernet Switch
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HOST INTERFACE SETUP

[ Storage Management Utility

System Status

System Time  2070-01-12 17:34:35

SystemEvents €34 0 W 0 A 0 (L 0

Configuration View

Configure Host Interface

Madify the settings for the host interface

Port A1 (FC}:

Port A2 (FC):

Port A3 (i5CSI):

Port A4 (iSCSI):

Port B1 (FC):

Port B2 (FC):

Port B3 (iSCSI):

Port B4 (iSCSI):

Speed. auto

Speed. auto

IP Address:* |1E.83.1 38.227

Netmask:* |255.255.24B.IJ

Gateway:*  [16.83.136.1

IP Address:™ |1E.33.1 36.228

Netmask:* |255.255.24B.D

Gateway:*  [16.83.136.1

Speed. auto

Speed. auto

=
Bl [ veims (P2000G3 FGASCSI)
& Logical
B Vdisks
@ Houston (RAIDS)
Connection Mode:  loop -
Connection Mode:  loop -
Connection Mode:  loop -
Connection Mode:  loop -

IP Address:* |15.83.1 38229

Metmask:* |255.255.24B.EI

Gateway:*  [16.83.136.1

IP Address:* |1E.83.1 36.230

Netmask:* |255.255.24B.IJ

Gateway:*  [16.83.136.1

MIDS)
MIDS)

velma (P2000G3 FC/iSCSI)

View » Provisioning » Configuration ~ | Tools =

velma (P2000G3 FC/iSCSI) >

Wizards «

Help

Configuration Wizard

Services

System Overvie

Select an entry from the table tf  “3EM%

4
4
System Settings ]
4
4

Advanced Settings
Remote Systems

System Overview Date, Time

Host Interfaces

Metwork Interfaces
System Information

TIP

«  Make sure you can ‘ping’ all the
Ethernet addresses prior to creating
any replication sets

Use CLI command “verify remote-link”
or the SMU's Tools -> Check Remote
System Link.




PROVISIONING WIZARD : VDISK CREATION
REQUIRED ON BOTH LOCAL AND REMOTE SYSTEMS

User: manage

[ Storage Management Utility

System Status
System Time  2010-04-11 17:05:40

velma (P2000G3 FC/iSCSI)

Provisioning =  Configuration » Tools » Wizards ~ Help

SystemEvents &3 0 % 0 /. 0 (i) 100

velma (p2| Provisioning Wizard rview
Configuration View

= Syste Ad Host
& [Es velma (P2000G3 FCASCSH) Selectan| CreateVdisk BE
B Logical Create Multiple Snapshots
B vdisk Delete Vdisks
ISKS
Delete Volumes m P— Storage Space
&8 vd-aneesh (RAIDS) ® (¢ Remove Hosts sere
Bl &8 Houston (RAIDS) - Manage Global Spares :
E= Volume Houston_v000 (9999.9MB) @ @ Delete Schedule L 26TE 12T LETE
Hosts @ ( Modify Schedule 12 2678 1578 178
- Delete Snap Pools
& Physical o Gow = - e
Enclosure 1
H Volumes 3 410.0GB ]
Snap Pools 2 B0.0GE . 0.
Snapshots a
Schedules a

Configuration Limits

Licensed Features

Versions

TIP: You must create a vdisk on both local and

remote systems prior to initiating a remote snap
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PROVISIONING WIZARD STEPS 1 & 2

Provisioning Wizard

Creste vdisks and volumes, and map volumes to hosts,

Step 1 of & Introduction

This wizard helps you to create a vdisk with velumes and to map the volumes to hosts. Before using this wizard, read documentation and Resource
Library guidelines for your product te learn about vdisks, velumes, and mapping. Then plan the vdisks and volumes you want to create and the default
mapping settings you want to use. The wizard guides you through these steps:

Specify a name and RAID level for the vdisk,

Select disks to use in the vdisk.

Specify the number and size of volumes to create in the vdisk.
Specify the default mapping for access to the volume by hosts.
Confirm changes and apply them.

For each step you can view help by clicking the help icon (n). If you cancel the wizard at any point, no changes are made.

To continue, click Next.

Previous

Map Volumes

Vdisk Settings Select Disks. Define Volumes Confirm

Enter the vdisk name

Assign the controller

Set the RAID level
Verify the Chunk size

23

Provisioning Wizard a

Create vdisks and volumes. and map volumes to hosts.

Step 2 of 6: Name and RAID level

For the vdisk that you are creating, select an appropriate RAID level for the level of fault tolerance that the vdisk's data will require and optionally change
the default name. A vdisk name is case-sensitive, cannot already exist in the system, and cannot include a comma, double quote, or backslash. For
information about RAID levels, and opticns you can set depending on the RAID level you select, see the online help.

“You can later change a vdisk's name and owning controller. After a vdisk is created you cannot change its RAID level or chunk size.

Controller B -
RAID level:* RAID-5 - Number of sub-vdisks:
Chunk size:
T T
Intreduction

Vdisk Settings Select Disks Define Volumes Map Volumes Confirm




PROVISIONING WIZARD STEPS 3 & 4

Provisioning Wizard ? |

Create vdisks and volumes, and map volumes to hosts.

Step 3 of 6: Select disks

:
« Select the disks to b
You can later add spares to or remove spares from the vdisk, assign spares for use by any vdisk, or enable dynamic sparing, as descriced in the onlin - e ec e I S S O e
help. M h d M k
placed in the vdis

Sets, Complete: Yes, Total Space: 500.0GB:

7]

« If desired designate a
N spare drive

m——mmmm

) ox Disk-1.1 _ 300.0GB Enclosure-1 ALM2ZHLLO000SE2ECYEL  Up _'

O ok Disk-1.2 SAS RAIDS 300.0GB Enclosure-1 3LM2XJ7HO0009B25C5HZ  Up '

© ok Disk-1.3 SAS m 300.0GB Enclosure-1 3LM3D2FKOO009E29NUS)  Up i

B @eox Disk-1.7 SAS AVAIL 200.0GB Enclosure-1 3LM31ZMLOD00SE2EWEEL  Up

B0 @cx Disk-1.8 SAS AVAIL 200.0GB Enclosure-1 3LM1REAZ0000E07

B @ok Disk-1.9 SAS AVAIL 200.0GB Enclosure-1 3LMTWLN80000S80!

B @ ok Disk-1.10 SAS AVAIL 200.0GB 1 3LM1TMF 7 Provisioning Wizard n
M1 " oK Nisk-1 11 SAS AVAI ann nGR Frnrlasire-1 Al M1RERMONNNSRNT

T . . Create vdisks and volumes, and map volumes to hosts.

e i

I - < . Optional. By default the vdisk wil have one volume using all space in the vdisk. & volume is a logical subdivizion of a vdisk and can be mapped to
LAEIEOEE LR ETiEs AEPUEIIES controller host ports for access by hosts. You can change the guantity, default size, and base name of volumes as described in the enline help.

-

“'ou can later add, rename, expand, or delete volumes.

Mumber of volumes to create:® (Press the Tab key after changing the value)

Volume size: 10 0GB [ I 599G6

Enter the nUmber Of Base name for volumes:
volumes to create

Enter the size of the
volume(s)

Enter the volume name, or
base name if multiple
volumes will be created

| Provous | Wt | Cancol ]

Introduction Wdisk Settings Select Disks Define Volumes Map Volumes: Confirm
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PROVISIONING WIZARD STEPS 5 & 6

SMU Action

Provisioning Wizard

Map:

Select ports from the view or list below:

Graphical

pt @‘\

Bl

N\ (B2
N - e

4 . B B = o5 =
. g 'l

Create vdisks and volumes, and map volumes to hosts.

Step 5 of 6: Set the base mapping for volumes

LUN:* l:l Access:  read-write -

SEEET T
B O B R

A

1683138157

ouPon

(7= ]

CutPort

Q==

« If you want the default
mapping you can assign it
here

It you want explicit
mapping you need to
perform that after the
wizard completes

Provisioning Wizard

Create vdisks and volumes, and map volumes to hosts.

Step 6 of 6: Confirm the vdisk settings

m correct, click Finish to apply changes and finish the wizard.
cont |

Introduction Vdisk Settings Select Disks Define Volumes

Map Volumes

« Verify all settings are

« Click ‘Finish” to complete
the provisioning wizard

25

correct

Vdisk name
RAID Level
Assign to
Chunk size
Number of disks

Number of spares

Size of volumes.
Base volume name
Map

Ports

Base LUN

Access

Houston
raids

b

B4k

3

a

MNumber of volumes 1

10GE
Houston_v
Yes
A1.A2,B1.62
El

read-write

Previous Finish
Introduction “disk Settings Select Disks Define Wolumes Wap Volumes

Confirm that the values listed are correct. If they are not correct, click Previous to return to previous steps and make necessary changes. If they are

Confirm







STARTING THE REPLICATION SETUP WIZARD

% Storage Management Utility

System Status
System Time ~ 2010-01-11 17:16:48

SystemEvents €% 0 W 0 4. 0 (I 100

=
Bl [ velma (P2000G3 FGASCSI)
—} B Logical
B vdisks
& vd-aneesh (RAIDS)
B &8 Houston (RAIDS)
& Volume Houston_v000 (3999.91B)
Hosts
& Physical
[ Enciosure 1
[ Daphne (P2000G3 FCASCS)

velma (P2000G3 FC/iISCSI)

View » Provisioning ~ Configuration » Tools + W% rds

velma (P2000G3 FCiSCSI) = View > Overview

Help

Provisioning Wizard

System Overview

Configuration Wizard

Replication Setup Wizard

Select an entry from the table to see the details

System Overview

[veat [ Component [ Count [ capaciy |

@) O oK System 28TE
© @ox Enclosures 1 36TB
o @ox Disks 12 36TB
o @ox Vdizks 2 1.2TB
i) Volumes 3 410.0GB

Snap Pools 2 80.0GB

Snapshots o

Schedules o

Configuration Limits

Licensed Features

Versions

Storage Space

TIP

« Select the top level system
- Select Wizards ->

Replication Setup Wizard

* You can follow and perform these steps on your Storage Array

« Just create a separate — non production — volume and follow along

* You can also perform these steps on a single G3 array

27




REPLICATION SETUP WIZARD STEPS 1 & 2

Replication Setup Wizard &

Prepare to replicate a volume

Step 1 of &: Introduction

This wizard helps you prepare to replicate an existing volume to ancther vdisk in the local system or to a remote system. Before using this wizard, read
documentation and Resource Library guidelines for your product to learn about replication. Then plan the storage systems, replication mode, and volumes
you want to use for the replication. The wizard guides you through these steps:

Select the primary volume, which is an existing volume.

Specify whether the replication mode will be local or remote. If the replication will be to a remote system that has not already been added to the
local system, you can add it. To do so, you must know the user name and password of a Manage user on that system and the system’s IP
address.

Specify the Secondary volume. You can select an existing replication-prepared volume or specify to create a volume in an existing vdisk that has

« The first step out lines all
the following steps

sufficient available space for the replicated data.
= Confirm changes and apply them.
For each step you can view help by clicking the help icon (a) If you cancel the wizard at any point, no changes are made

To continue, click Next.

Primary Volume Replication Mode Secondary VWolume

« Make sure you have
completed all the
prerequisites

Cancel

Confirm

« Select the ‘Primary Vdisk’

« Select the ‘Primary Volume'

28

Replication Setup Wizard EA
Prepare to replicate a volume

Step 2 of 5: Set Primary Volume

Select a primary volume to replicate.

Primary System: Velma

Primary Vdisk:  Houston -

Primary Wolume: _Huustnn7v001 -

. T

ﬁmy\.r‘uim Replication Mode Secondary Volume Confirm




REPLICATION SETUP WIZARD STEPS 3 & 4

Replication Setup Wizard

Prepar o replicats 2 volume

Step 3 of 5: Set Replication Mode
You can set the replication mode to be either local or remote. With remote replication, you also have the option of adding a new remote system.

) Local Replication

@ Remote Replication

Remote System:  (Chooseasystem .. .__.._....J

Check Links: [7] | e
| Fred-FC

Add new Remote System
User Name: l:l
Password: :l

Add Remote System

Replication Mode:

Confirm

Primary Wolume

Secondary Volume

Step 4 shows vdisks
available on the remote site

Select a remote vdisk
Select the desired link type

if the remote system has a replication prepared volume of
the same size of primary volume , it will be available in

the “Use existing volume” drop down box.

Select either ‘Local’” or ‘Remote’
replication

It your remote system is already
identified, select it from the drop down

box

If your remote system is not yet
discovered, add it here

It user selects check link box it will verify
the link between the systems

Replication Setup Wizard

Prepare to replicate s volume
Step 4 of 5: Select Secondary Volume

Select a secondary velume. If you specify to create a volume then a volume of the appropriate size wil be created on the secondary vdisk. If no existing
volumes are appropriate to use, the secondary volume options will be grayed out but you can stil select a vdisk.
Secondary System: Daphne

Secondary Volume:

@ Create new volume on vdisk {New_York

Use existing replication prepal Fort Colins

Link Type:  iSCSI g

T T
Introduction Primary Volume Replication Mode ‘Secondary Volume Confirm




ADD REMOTE SYSTEM

[ Storage Management Utility

System Status
SystemTime  2010-01-11 17:04:59

SystemEvents €3 0 W 0 /0 (1 100

[~ ] ++]
Bl [Es velms (P2000G3 FCASCSI)

Bl Logical
Bl Vdisks
& vd-aneesh (RAIDS)
Bl & Houston (RAIDS)
= Volume Houston_v000 (3995.3MB)
Hosts
& Physical
[E Enclosure 1

View »

System Overview

© @ox
& Qo
© @ox

Provisioning -

velma (P2000G3 FC/iSCSI) >

System Overvie

Select an entry frem the table t

Services
Users
System Settings

Enclosures
Disks
Vdisks
Volumes

Snap Pools

Snapshots
Schedules
‘Configuration Limits
Licensed Features

Versions

Configuration -

Advanced Settings

Tools »
Configuration Wizard

- v v v

Wizards «

Delete Remote System

3.6TB
1278
410.0GB

20.0GEB

Help

Storage Space
3 6TB

User: manage
Sign Out

TIP

You can also add a remote system manually, prior to starting

the replication wizard.

Highlight the system in the left pane

Click Configuration -> Remote Systems -> Add Remote System

Enter the IP Address, Username and Password

30

View » Provisioning » Configuration » Tool

velma (P2000G3 FCASCSI) > Configuration > Remote

Add Remote System

Add a new Remate System definiticn

P address® |16.83.138.70 |

User Name:* |manage |

Password: |u-"“ |

Create Remote System




REPLICATION SETUP WIZARD STEP 5

SMU Action

Replication Setup Wizard 2 |

Prepare to replicate a volume
Step 5 of 5: Confirm the replication settings

Confirm that the values listed are correct. If they are not correct, click Previous to return to previous steps and make necessary changes. Ifthey are
correct, click Finish to apply changes and finish the wizard.

« Verify all settings are

Primary System Velma

= correct
Primary Vdisk Houston

Primary Volume Houston_v001
Secondary System Daphne

« Click ‘Finish’ to complete

Secondary Vdisk New_York

the replication setup
Secondary Volume = rHouston_v001 X
Link Type iscs! WIZJd rd
Check Links Yes
_— T
Introduction Primary Volume Replication Mode Secondary Valume Confirm

e
« This establishes the replication
set but does not start the O

repl |CGh On process ﬁ Establishing replication for volume Houston_v000 was successful. You can now replicate the volume aor

schedule a replication for a later date

« Atter clicking ‘OK’ you will be

placed at the screen to replicate
the volume

31




SCHEDULED REPLICATION OPTIONS:
REPLICATE ‘'NOW' OR ‘SCHEDULED’

Replicate Volume

Replicate a volume

) Now F Scheduled

Replication image prefic:* rLogl

@ Create new snapshot, then replicate
Replication Mede:

Replicate most recent snapshot

Replication images to Retain: 2 i

— Scheduled replications have many

options
« For details click the “?” icon

Start Schedule Date [2010-03-08 |77 Tme[11 [fos | 240 ~
Y- (MM

(FIYY-MEFDD) (HH)

@ One Time

@ Every Minutes

Recurrence:

@ No Time Constraint

Between : 24H and : 24H
] (MM} {HH) (MM}

Time Constraint:

View =  Provisioning ~ Configuration » Tools «

External-view Volume Houston_w000 (9999.9MB) > Provisig

Replicate Volume

Replicate a volume

@ now | O scheduled

Replication image name:* |HIJI.I3tIJI'I_VUUU_iU1 |

! Mo Date Constraint

Date Constraint: Any | Day of | Year

Day number of | Year

! Continuous

End Schedule: Date [2010-03-08 Time 11 [[11 ] [24H

(YYTTIAN D) (FH) (MM}

End after OCCUMTENCEs

32

» Non-scheduled replications “Now" are
immediate

— Creates a replication when the Apply button is
clicked. This replication must be manage
manually

TIP — keep your schedules simple




SYSTEM VIEW WITH REPLICATION
LOCAL SITE:

B B Veima (PR000G3 Fe/SCS)
B Logical

B viss Name Definition
& 8 Houston (RADS) o Vol | T oriainal “Voloma”
e origina olume
% ; Hoston,v001 (493G8) romary voliume <volume 9
' name>
'ﬁ:g Remote Secondary Volume rHouston_v004 on Daphne

Lﬁepfication images Remote Secondqry Volume View of the remote volume on the local site —
<remote volume name> note the volume name will start with ‘r’ and it
is residing at remote system

Snap Pools . . . .
Replication Images Tree branch showing local site replications
L{ » 3nap Pool spHouston_v001 (9553 508}

1] Hosts Rep|icc’rion Image <creation Subcomponents/Nodes of replication images
B Physical date/time> (snapshots) branch showing individual local
site replications

L Replication Image 2010-10-25 17:42:07

- [ Enchosure 1
| B Do (RO00G3 OS] Snap Pool <name> An internal volume, which cannot .be hos’r.
mapped, used to store data associated with
replication snapshot at local site.

[ Fred-FC (2000 G3FC)

» As replications are initiated replication images will
appear under the volume to which they belong

- None of the replicated images will appear on a server
until they are exported to a snapshot and mounted
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SYSTEM VIEW WITH REPLICATION:

REMOTE SITE

& [ Daphne (P2000G3 FC/SCS)
B Logical
B Vdisks
B3 &8 New_York (RAIDS)
% Secondary Volume rHouston w001 (45.5G6)
£ Remote Primary Volume Houston_v00M on Velma
i Replication Images
- &1 Replication Image 2010-10-25 17:42:07
Snap Pools

L (f:} 3nap Pool spriouston_v001 (3559.5MB)

— B3 Fort_Collins (RAIDS)

Hosts
B} Physical
L B Enclosure 1

= % ‘Velma (F2000G3 FCASCS)

Secondary Volume
<remote volume name>

Remote Primary Volume
<volume name>

Replication Images

Replication Image
<creation date/time>

Snap Pool <name>

Holds a replica of the original “Volume”.
This volume is NOT mountable — note the
volume name will start with ‘r’

The original “Volume” represented on the
remote site, resides on the local site

Tree branch containing remote site’s
completed remote replications

Subcomponents/Nodes of remote sites’
replication images (snapshot) branch
showing individual remote site completed
replications

An internal volume, which cannot be host
mapped, used to store data associated with
replication snapshot at remote site.

As replications are initiated replication images will appear under the volume to which

they belong

None of the replicated images will appear on a server until they are exported to a

snapshot and mounted
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INITIAL REPLICATION

— The initial replication between a primary and secondarT/ volume
requires that a full data copy occur between the two volumes

« What this means is that an initial replication will copy every block on the
volume

- This can take a significant amount of time depending on the amount of data
and the link between the local and remote sites

— Once the copy is completed, the first replication image (snapshot) is
taken on the remote volume, resulting in a “replication sync point”
« This replication sync point indicates the replication image (snapshot) on the
local site and the remote volume are identical

TIP: To help manage the initial replication you can perform a Physical
Media Transfer
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PHYSICAL MEDIA TRANSFER

— A physical media transfer is a process by which you perform a local replication of
the volume(s) to be transferred

- This must be done to a different set of disks(make sure secondary volume resides on a different vdisk).
- Once the replication is complete, perform “detach” operation on secondary volume.

- Once “detach” is completed do “stop” operation on the vdisk which has the secondary volume

- Move the physical disks to the remote site and insert disks to the remote system

- Perform “start” operation on the vdisk, followed by “reattach” operation on the secondary volume.

— Manual data transfer steps

- Detaching a replication volume
— Used to physically remove a replicated volume from the local system.
— Must be performed prior to doing “stop” operation on the vdisk
— Detached volume remains part of the replication set but is not updated
— If you intend to move the disks' drive enclosure, it should be at the end of the chain of connected enclosures.
— Before removing drive enclosure from the system, shut down or power off the enclosure
— Ensure that the Detach Replication task completed successfully
— Atter the drive enclosure is powered off there will be unwritable cache data in the drive enclosure
« Reattaching a replication volume
— Do “start” operation on the vdisk.

— Now “reattach” a replication volume that has been physically moved from another system into this system. After the volume is
reattached, the replication set can resume replication operations.

TIP => Best practice is o power down the enclosure or shutdown the controllers before inserting the disks
prior to reo’r’raching the volume. Otherwise you may wind up with “leftover” disks and the vdisk would need
to be reconstructe
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RECOVERY OPERATIONS

— Now that we have created a replication, let’s look at recovery
operations/options in the case of disaster or an accident

— We'll examine
« How to bring up a recovery site

« How to bring the local site up-to-date
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DISASTER RECOVERY: NODE RELOCATION

— Remote Snap has the ability to bring
up a disaster recovery site

- To bring up a remote site the secondary Houston
. . Server

volume must be converted to a Primary
Volume

—Rollback to a snapshot on the remote site —

this will keep track of any changes that

happen on the remote site

— By default the volume syncs to the latest
replication snapshot

— Any data that has not been replicated is lost

«New Primary Volume (on the remote site)
can be mapped to a LUN and used just as
the original volume was used.

39



HOW TO BRING UP A RECOVERY SITE

— Converting a secondary volume to primary volume can be done via

SMU or CLI

— Now you can mount the volume “rHouston_v001” to the host(this volume is
now the primary volume)

— To fail back convert the primary volume to a secondary volume

TIP: Since secondary volumes cannot be mapped, un-map the primary
volume before converting it to a secondary volume
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CONVERTING A SECONDARY VOLUME TO
PRIMARY VOLUME USING CILI

— Through CLI, change the secondary volume to a primary volume
» set replication-primary-volume volume rHouston_vO01 primary-volume rHouston_v0O1

« NOTE: (rHouston_v001 is your secondary volume and this command must be run for your

remote system, after this command is run successfully rHouston_vO01 will become primary
volume)

— Now you can mount this volume (rHouston_v001)

{TIP: Since the volume was previously a secondary volume , it had no

mapping. You'll need to map it after converting it to primary volume so that
hosts can mount it.}

— Application/s can now be switched to rHouston_vOOT - this is our new
primary volume at the remote system

replication-primary—volume volume rHouston_vBB1l primary-volume rHouston_v@@1
: Setting the primary volume of the replication zet. Thisz may take a couple of minutes...
: Started setting the primary volume of the replication set. (rHouston_v@81)>

! Successfully set primary volume of peplication set rHouston_vBB1 to rHouston_vBB1. (rHouston_vB@1>

Success: Command completed successfully.




CONVERTING A SECONDARY VOLUME TO
PRIMARY VOLUME USING SMU

— Using SMU, change the secondary volume to primary volume

NOTE: (in the example below, rHouston_vO01 is our secondary volume)

— Now you can mount this volume (rHouston_v000)

— Application/s can now be switched to rHouston_v00O - this is our new primary volume at
the remote system

wstem Time  2070-10-26 10:23:11

View » Provisioning v Configuration v Tools v  Help

ystemEvents €3 0 W 0 4 1 (D 99

Secondary Volume rHouston_w(01 (49.9GB) > Provisioning > Set Replication Primary Volume
= Set Replication Primary Volume

B2 [ Daphne (P2000G3 FCASCSI)
X Logical

= Vdisks Primary Volume: :rHouston_w001 Pw

Set the replication primary volume

H .@- Hew York (RAIDS) Set Replication Primary Volume

% Secondary Volume riHouston_v007 (49.9GE)

— gy Remote Primary Wolume Houston_v001 on Velma
L Replication Images
Snap Pools

_ B8 Fort_Collins (RAIDS)
£ Hosts
& Physical

L § Enclosure 1

— B veima (P2000G3 FeriSCS)




Secondary volume has been converted to Primary Volume

M Secondary Volume rHouston_v001 (49.9GB)

emEvents €3 0 W 0 /% 1 (i) o9

B [E= Daphne (P2000G3 FC/isCS)
B3 Logical

B vdisks

B3 BF New_York (RAIDS

@ Primary Volume rHouston_v001 (49 9G8)
@ Remote Primary Volume Houston_v004 on Velma
Replication Images
L _- Replication Image 2010-10-25 17:12:07

Snap Pools

_@ Fort_Collins (RAIDS)

Hosts

El Physical
| [E Enclosure 1

— [B veima (P2000G3 FCASCSI)

View = Provizioning » Configuration » Tools = Help

Secondary Volume rHouston_v001 (49.9GB) > Provisioning > Set Replication Primary Volume

Set Replication Primary Volume

Set the rEpri{at.im primary velume

Primary Wolume: ..H.E;U-ﬁ'.';t-ﬂl'l__- 1.rIZHZH -

Set Replication Primary Volume
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DISASTER RECOVERY FAILBACK

— Once the catastrophic failure has been addressed, if the user wishes to
move the disaster volume back to the original volume, a series of steps will
need to be followed

1. Make the original primary volume (be sure to Un map it first ) a secondary volume
= As a secondary volume it can receive data from the current primary volume
2. Replicate any data written to the remote disaster volume to the original primary
volume (now set as a secondary volume)
= Can be performed in a single replication or in multiple replications

= Host access to the disaster volume (currently primary volume residing on remote
system) should be halted. This is to ensure that all data has been transterred properly

3. Once data has been replicated back to local site, convert the secondary
volume(original primary volume at local site) back to primary volume and
convert the disaster volume(primary volume at remote site) to secondary
volume.

4. Move the applications to the original primary volume at local site.
5. Re-establish the replication set to the remote site.
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ADDITIONAL TERMINOLOGY

— Replication Sync Points
« When a snapshot is replicated from the local to remote sites, the snapshot becomes
a replication sync point
« The sync point is a set of data that is represented on both local and remote
locations
« Used to determine the delta data from that sync point to a later snapshot
« Note that a snoEshot is considered a sync point only when the same point-intime is
represented on both locations
— Queued Replication Snapshots

- New replications can be initiated even while other replication snapshots are in the
process of being replicated

- Allows user to create replications at discreet intervals even while other replications
are ongoing

« A replication initiated while another to the same remote volume is ongoing will be
queued, and will not actually begin to transfer data until the current replication
completes

45




OTHER TASKS YOU CAN PERFORM PART 1

— Replicate a snapshot

- Provides the capability to replicate an individual snapshot to the associated
replication volume

- Only snapshot preserved data is replicated; snapshot modified data is not
replicated.

— Removing replication from a volume

- If you no longer want to replicate a volume, you can dissolve its replication
set. When a replication set is dissolved:

— A rollback is automatically performed to the latest available snapshot on the replication
destination volume to ensure that data is consistent.

— Any replication images associated with the replication volumes are converted to standard
snapshots. Snapshots are converted regardless of the number of snapshots allowed by the
system's license.

— There is no longer a relationship between the volumes or their snapshots on the two systems
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OTHER TASKS YOU CAN PERFORM PART 2

— Suspending replication
» You can suspend the current replication operation for a selected volume
» You must perform this task on the remote system that owns the replicated volume

« Once suspended, the replication must be resumed or aborted

— Resuming replication
» You can resume a suspended replication operation to resume normal operation

» You must perform this task on the system that owns the replication destination
volume.

— Aborting replication
« You can abort the current replication operation for the selected replication volume.
The current replication may be running or suspended.

» You must perform this task on the system that owns the replication destination
volume.
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OTHER TASKS YOU CAN PERFORM PART 3

— Exporting a replication image to a snapshot

« You can export a replication image to a standard snapshot. For example, you could export
a replication image from a secondary volume for use on the remote system.

« The exported snapshot can be used like any other standard snapshot, including being
mapped or deleted. Changes to this snapshot will not affect the replication image.

« NOTE: The task will not succeed if the resulting snapshot would exceed license limits.
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UNDER THE HOOD:
REPLICATION INITIAL COPY

When the remote copy operation is
initiated, a snapshot is created to
capture the current state of the
Primary Volume

Monday t
6 PM

The information is actually read from
he snapshot. When no data is in the
snapshot, the data is grabbed from

the Primary Volume

Monday
6 PM

Snap Pool Snap Pool
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UNDER THE HOOD
INITIAL COPY - BLOCKS CHANGING

Often, during a remote copy
operation, data will change. Those
changes are captured in a snapshot

The block C’ is not copied at this
point, only data at 6PM, when the
replication operation started, is
copied

Monday

When data is in the snapshot, the }
6 PM

data is grabbed from the snapshot

Snap Pool Snap Pool
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UNDER THE HOOD:
SECOND REPLICATION PART 1

[ 1 Remote copy a day starting at 6pm }

~
The Remote site still
represents the Primary site as
it was at 6PM on Monday
_/

Over the course of the day the
Primary Volume changes

[A][8][c][o]

Blocks E/F/G are not copied to the snapshot at
this point. Snapshots track changes to existing
blocks — not new data.

Changes are not placed in the
Remote Monday snapshot until
the next replication operation

starts

At 6PM on Tues another replication
operation starts... at this point a
new snapshot is created

Tuesday
6 PM

Tuesday
6 PM

Changes from Monday at 6PM
are captured in the snapshot

Snap Pool Snap Pool
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UNDER THE HOOD:
SECOND REPLICATION PART 2

Once the replication operation is
J complete the sites are back in sync —
except for any data that may be in
the Tuesday snapshot

[ 2nd Remote copy starting at 6pm

[a][8][c][o]

7

As the Remote Volume is
update. Changed blocks are
stored in the snapshot

The system tracks the
changes to determine
what information needs
to be copied

<>

Changes from Tuesday at 6PM
are captured in the snapshot

Tuesday
6 PM

Tuesday
6 PM

Monday
6 PM

Snap Pool Snap Poo
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UNDER THE HOQOD:

SECOND REPLICATION PART 3

2nd Remote copy starting at 6pm J

-
Over the course of the day the
Primary Volume changes

X 5] (€] B
T T T ——
‘/

Before a block is changed, the }

original information is captured

6PM and stored in the snapshot

Snap Pool Snap Pool
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Tuesday
6 PM

Monday
6 PM
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UNDER THE HOQOD:
THIRD REPLICATION

3rd Remote copy starting at 6pm J Once the replication operation is

complete the sites are back in sync —
except for any data that may be in the
Wednesday snapshot

The system tracks the
changes to determine
what information needs
to be copied

- G
Wed Changes from Wednesday at 6PM Wed
6 PM are captured in the snapshot g ISM
Tuesday Tuesd
se
Monday Monday
6 PM 6 PM

Snap Pool Snap Pool
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For more information, helpful tools
and resources please visit the following sites:

Web pages:

HP P2000 G3 Remote Snap
www.hp.com/go/RemoteSnap

HP P2000 G3 FC/iSCSI Combo Array
www.hp.com/go/P2000

Whitepapers:

Upgrading the HP StorageWorks MSA2000 G1 to the P2000 G3 MSA
http://h20195.www?.hp.com/v2/GetPDF.aspx/4AAQ-8284ENW . pdf

Upgrading the HP StorageWorks MSA2000 G2 to the P2000 G3 MSA
http://h20195.www?2.hp.com/v2/GetPDF.aspx/4AAQ-8 304ENW .pdf

Best Practices for HP MSA2000 G1, G2 and P2000 G3
http://h20195.www?2.hp.com/v2/GetPDF.aspx/4AA0-827 9ENW. pdf

Follow us on twitter and be a part of the conversation, and get the latest P2000 G3/MSA related news and

information at:

http:/ /twitter.com/MSAstorage

[

invent
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